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1 Introduction

The RELOAD Editor is a Content Package and Metadata editor. With RELOAD, you can take your
own electronic content (web pages, images, flash animations, Java applets etc.) and package
and describe it ready for storage in content repositories such as those maintained by the
JORUM+ project. (http://www.jorum.ac.uk/)

The RELOAD editor is of significant value to the UK Higher Education community and beyond,
since it provides the crucial "missing link" which allows users to author and transfer learning
objects, in specification compliant format, between authoring and design tools, local and
distributed digital repositories, and Virtual Learning Environments (VLEs).

IMS Specifications

The RELOAD Editor implements the IMS Content Packaging and Metadata specifications. If you
are not familiar with these specifications then it will be helpful to refer to the documentation
available at the IMS web site:

CONTENT PACKAGING: http://www.imsglobal.org/content/packaging/index.cfm
METADATA: http://www.imsglobal.org/metadata/index.cfm

At present, the RELOAD Editor supports v1.1.3 of the IMS Content Packaging specification and
v1.2.2 of the IMS Metadata specification. v1.1 of the RELOAD Editor also offers the option to edit
SCORM 1.2 packages. Information on SCORM is available from ADLNet: http://www.adlnet.org/

Where to get RELOAD:

RELOAD is free software (released under the MIT Open Source license) and is available for
download from the project web site at http://www.reload.ac.uk/

RELOAD is under active development, but since version v1.1 (11 August 2003), RELOAD has been
stable and fully functional. Subsequent versions will provide improvements in usability and
customisability.

This Guide

This document has seven sections:

this Introduction section provides some background to the RELOAD Editor tool:

the Getting Started section describes the installation process and the user workspace,
the Tutorial section describes the whole process of creating a simple content package,
the Metadata section provides further information on the Metadata features of RELOAD,
the Supporting Other Application Profiles and Vocabularies section describes how to
customise RELOAD to your individual needs,

the SCORM Elements section describes the SCORM functionality,

e the Further Actions section describes some more advanced features of RELOAD.

The screenshots used in this document are taken from the v1.1.1 release of RELOAD Editor.

We are always keen to improve RELOAD and the documentation that
accompanies it. And we are also keen to know who is using the tools and
for what purpose. Please get in touch with your ideas, comments,
suggestions and testimonies by sending email to:
colin.milligan@strath.ac.uk

Thank you
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2 RELOAD Editor

The RELOAD Editor is a Java application, and should run on any platform capable of running Java
applications. From the RELOAD web site, installation packages are available for the Microsoft
Windows and Macintosh (OSX only) platforms. The install file for Windows includes a copy of the
Java Runtime Environment (JRE) which is installed under the RELOAD Editor installation
directory. This JRE (v1.4.1) should not interfere with other Java Virtual Machines installed
elsewhere on your system. The Install for Macintosh does not include a JVM, but utilises the
system JVM.

The information and instructions given here (and throughout this document) pertain to the
Microsoft Windows version of the tool. Other versions should function in (much) the same way -
though they may look different.

System Requirements (MS Windows)

To run RELOAD Editor you should have a PC with at least the following specification:
¢ Intel Pentium 3 (or equivalent) Processor, 800Mhz,
e 256 Mb RAM,
e Microsoft Windows 95, 98, Me Windows NT4.0, Windows 2000 or Windows XP,
e A Web Browser for viewing Content Packages.

Installation (MS Windows)

To install the RELOAD software, download the most recent install file from
http://www.reload.ac.uk/download/. The download file is approximately 19Mb. This equates to
a download time of around 80 minutes on a 56kbps modem (assumes sustained transfer rates of
4k/s). Obviously the download time will be much reduced if you use a broadband or an
institutional connection.

Setup_Reload
1_1 Win.exe

Once download is complete, simply double click on the Installer and follow the on-screen
instructions. The installation allows you to choose where to install the software.

RELOAD Editor is installed to 'C:\Program Files\Reload Editor\" by default, although you can of
course change the location. Once installation is finished you can launch the RELOAD Editor by
clicking on the Start Menu and finding its' Program Group:

@ Reload Editor (¥ | By Reload Editor

A Uninstall Reload Editor

Uninstalling (MS Windows)

To remove RELOAD Editor from your system (and prior to upgrading to a new version of the
software), click the 'Uninstall Reload Editor' Icon in the RELOAD program group.

@ Reload Editor (| By Reload Editor

n Uninstall Reload Editor

If you chose not to create a Program Group, you will find the relevant file at: C:\Program
Files\Reload Editor\UninstallerData\Uninstall Reload Editor.exe or wherever you installed to.

On uninstall, files and folders you have created in the RELOAD Installation directory will not be
removed.
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RELOAD Workspace

The RELOAD Workspace basically consists of three panes: a resources pane (left), a manifest
view pane (right), and an attribute view pane (bottom). The manifest pane is the key area as
this space represents the structure of our content package - with a Manifest containing

Metadata, Organizations and Resources. The attribute pane includes a section with context

sensitive information on the currently selected element as well as a table of values and a box for
data entry.

I

"4 Reload Editor =Jokd
File Edit Options View ‘Window Help
D @B | { @ X|+ % B o | D B &
2 Content Package - testpkg = =] B2
- s 4
m i X | Prafile: ||m5 11 |
r:él testiky MAMIFEST-DCFDADTF-AG3F-6E2C-F22B-TF1F 440721 SE
- i supp - Metadata
""" W cicht il w0 organizations
""" W five il rél Rezources
----- ‘ four Html
----- @ imacp_w1pl xed M f t P
----- ‘ imztnanifest xml anlies ane
----- 2 itnzmad_w1p2p2 xad
----- iz _xml.xsd -
""" & ore i 'Metadata
----- ‘ seven.hitnl
_____ ‘ i Hrmd Acdd Metadata to this node.
A You can edit the Metadata
----- thres hitml !
_____ = t'-.n.tsef'rtm:n il | hisl:lE | fram the Edit menu ar by
Aﬁrl bute Pane clicking on the button on the
Resources Pane taolbar.

Each window represents a Content package and multiple windows may be open at any one time.
If you wish to view the Metadata associated with a particular content package, then a new
window is launched in addition to the Content Package window.

L'i Metadata - testpkg E
Edit

o W B N 8

Form  Full |

h Matrne I “alue Attr
= tetadsta -

=l General
- Tile
o LangString Surntner Pictures Eeh
----|:| Catalog Ertry
------ & Language eh
E||:| Description
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Toolbars
The RELOAD Editor has two toolbars. The Main Toolbar, with general options, and the Resource
Pool Toolbar with access to actions specific to the Resource Pool.

Main Toolbar
D @ ~ | @ X |+ % |B w|J

From left to right, the icons represent (with equivalent menu actions in brackets):

New (File New) creates a new Content Package (SCORM or IMS) or Metadata Record.

Open (File Open) opens an existing Content Package (CP) or Metadata Record.

Save (File Save Ctrl+S) to save the current CP or Metadata Record.
Undo (Edit Undo Ctrl+Z) to undo the last action.

Redo (Edit Redo Ctrl+Shift+Z) to redo the last action.

Cut (Edit Cut Ctrl+X) to cut the current selection.

Copy (Edit Copy Ctrl+C) to copy the current selection.
Paste (Edit Paste Ctrl+V) to paste the contents of the clipboard.

Delete (Edit Delete del) to delete the current selection.
Move Up (Alt+Up) to move the selected file within the CP.

Move Down (Alt+Down)to move the selected file within the CP.

Edit Metadata (Edit Edit Metadata) to edit metadata for the selected manifest.
Edit SCORM (Edit Edit SCORM) properties for a given Item.

Make Content Package (File Zip Content Package) to create a .zip CP.

)| 4 | o ||| B | 2<||2 |5 O|§|3

=
=

O

View File (View View File)to view an individual file (via browser).

& @G

Preview Content Package (View Preview Content Package) previews the CP.

Resource Pool Toolbar
B i X

From left to right, the icons represent (with equivalent menu actions in brackets):

@ Import to Resource Pool
#m| Create New Folder

> | Delete from Resource Pool

Refresh, refreshes the file list for the Resource Pool.

View File, launches a browser window to allow viewing of an individual file.

You will also come across other icons in system menus. These will be explained as we encounter
them.
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3 Tutorial

This section takes you through the creation of a simple Content Package.

Exemplar Content

To understand fully the facilities offered by RELOAD Editor, you must create and work with
content packages. The pages which follow lead you through all the stages in creating a simple
content package.

If you wish to have a look at the content package that is created by the Content Package tutorial
you can find the final file here: http://www.reload.ac.uk/ex/testpkg.zip (140k). Either unzip
the file and look at the individual files in your file browser, or use the RELOAD Editor to open
this content package.

Opening an Existing Content Package

If you wish to open an existing content package choose File, Open from the File menu. This
displays a dialogue box which prompts you to choose either a Zip file or .xml manifest. If you
choose a Zip file, you will be asked to choose a folder to unzip to, and this will subsequently
become the working directory for the Content Package. Dragging a Zip file (or imsmanifest.xml)
onto the RELOAD workspace can be used to quickly open packages.

Collect Resources Together

A Content Package is a means of transferring a set of resources from one location to another
whilst retaining their structure and inter-relationships. When creating the content package we
create a space in which all local files are kept - a root. As we build the content package, all the
files we use will be stored under this working directory, but their original location can be
anywhere on the local machine (indeed external resources can be referenced by hyperlink, but
we will only deal with local files here). For simplicity, we will start out with all the files that we
envisage using within a single directory structure. If you wish to work through this tutorial
yourself, you will probably set up something similar.

Create Directory Structure

Define a single directory for content packages on your computer (e.g. c:\cp). Within this
directory, make a new directory called test-src (c:\cp\test-src). Within that directory, you will
place all the files you need for your content package.

Download the source zip file http://www.reload.ac.uk/ex/test-src.zip (131kb) and extract to
c:\cp\test-src. The directory should now hold 8 .html files, as well as a sub-directory (supp)
containing 9 images and a stylesheet.

Create another directory testpkg at the same level as test-src (c:\cp\testpkg). This directory
will be used as the working directory for our content package. Your directory structure should
resemble that shown below.

?Ea test-src L.___IL;IJﬁ1
e

. File Edit ‘“iew Favorites Tools Help
| Address |[[3) C:\ep\test-sre M =
LU e @ @
= '_!ﬂ My Computer L) I
= < Local Disk (C1) [_] supp eight.html five, himi four.htmil =
(= R A
(L) testpkg
= 3 [restsre 0 0 0 0
£ supp M one.himil seven. himi six, hitml three.html M
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Open RELOAD and Set Up Workspace

Launch RELOAD editor (either from the start menu or desktop shortcut). By default, the Editor
opens up with no files open. we want to create a new Content Package, so:

Click File, New, > IMS 1.1.3 Content Package. A dialog box appears and you are asked to select a
folder for the content package. Navigate to c:\cp\testpkg, select this and click Open.

L-i Select Folder for Content Package E

Look in; I@teﬂpkg LI EI

File narne: IC:'IJ:p'I:testpkg Ok

Files of type: I'ﬂ"" File= ll Cancel

A new window appears with the title Content Package - testpkg and three frames showing:
e the tree structure of files and folders (the resources view),
e the main content package (the manifest view),
¢ information about individual elements (the attributes view) .

o = 1
L& Reload Editor =JI0JEd
File Edit Options Wiew Window Help
O @« ~| % @ X|+ % |l oD (1]
2 Content Package - testpkg 131 =l
i 4
W & X | Profie: [Ms11 <]
% testpky MANIFEET-564 ACSE62-5EF4-13C2-853F -3CACEEI 560
o 2] imscp_vipt xsd -} organizations
' """ * imsmanitest.zml - % Fesources
Eo B imsmd_vl p2p2 xed
------ ims_xml.xsd
|‘ i |I'l.|'|anifest
Attribute | ‘value | The Manifest node of the Content
[Eiaze Package contains EI:II child elements
lidertifier |MAMFEST-SE48CS62-.., | And dther sub-Manifests.
WErsion g s ;
A reusable unit of instruction.
Encapsulates meta-data,
organizations, and resource
references.
H———————. — — — — — — —

On creating the content package, the RELOAD Editor automatically creates the main data: file:
e imsmanifest.xml - the manifest for this Content Package, where all the information will

be stored. (the name imsmanifest.xml is mandatory, and this file must appear in the root
of any valid content package).

©RELOAD 2003 page 8
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You can view the imsmanifest.xml file by selecting it and clicking on the view file icon in the
Resource Pool toolbar. This will show you the initial structure if the manifest file once we have
added content and metadata we can re-examine this file.

Three other files are created, each referenced by the manifest.
e imscp_vip1.xsd - a local copy of the the content packaging XML Schema Document
e imsmd_v1p1.xsd - a local copy of the the metadata XML Schema Document
e ims_xml.xsd - a local copy of the XML Schema Document

Add a Reference to Metadata

At the moment the Content Package contains no content, before we add any content, we should
add some metadata, or rather, a placeholder - we will add the metadata later.

Right-click on the manifest icon in the manifest pane and choose Add Metadata.

Right-click on the Metadata Icon that is inserted and click Add Schema.

Select the schema and type 1MS Content into the value field.

Right-click on the Metadata Icon again and this time click Add Schema Version.

Select the schema version and type 1.2.2 into the value field at the foot of the window.
Although we have yet to add any metadata, we have defined the format of any metadata we will

add as conforming to the IMS Metadata specification v.1.2.2

The metadata node in the manifest view should now look similar to the one shown below.

i =
'+ Reload Editor =)<
File Edit Options Wiew Window Help
D« ~|f 2@ X[+ # Buo| @ RBF
2 Content Package - testpkg 131 =l
A 4
w b [F o Profile: ||w|51.1 vI
%l testpky MANIFEST-564 A C562-56F 4-1 3C2-853F -8CCE89 40564
- 12 imscp_v1pl xsd El Metadata
f W imsmanitest zml L e IMS Contert
fo E imsmd_vip2p2xed | 0 L g 22
o img_xpml.xzd [} organizations
‘B Resources
|Manifes’t
e The Manifest node of the Contert
.ﬂ-.ttrik:uutel e I Packane containg all child elements
[Baze and other sub-Manifests.
lidertifier  [MAMFEST-SE4AC562- ...
W ersion A reusable unit of instruction.
Encapsulates meta-data,
— —

Adding Organizations and ltems

Now we need to add some content. For our simple content package we have all our content
stored in one place, but we need to Import the Resources into our resource pool.
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Import Content
To create our content package, we must first import some content.

From the File Menu, select Import, Import to Resources Pool ... This brings up the Import
Resources File Dialogue. You could also click the Icon in the Resource pool toolbar.

Navigate to the source directory you made earlier (c:\cp\test-src\).
Select all the files, including the subdirectory.

Check the 'Include Dependent Files' Option. The RELOAD Editor will parse html files etc. to find
dependent images, stylesheets etc.

Click Open. Click Yes if asked to overwrite files (e.g. stylesheets and logo's which may have been
referenced in more than one file).

The files you imported now appear in the tree view on the left hand side of the RELOAD
workspace. You should see the eight .html files in the root space, as well as the supp folder
containing the images and stylesheets.

Your workspace should resemble that shown below:

S — =

L4 Reload Editor -JoJEd

File Edit Options Wiew ‘Window Help

D@ > 2@ X[+ + Bwo 3R @

2 Content Package - testpkg =|21 %l
W > W Profile; ||w|5 1.1 "I
] testpkg MANFEST-564AC562-56F 4-1 3C2-683F -BCOCEE0ACEEA
-l supp =B Metadata
""" W eight it & MS Content
----- W five himl @122
""" W four bl . Organizations
""" 8] imsep_vipt xsd & Resources

----- 'ﬂ- imarmanifest xml
----- E imamd_wlp2p2xesd ==

----- ima_xml.xad | Manifest

----- 'ﬂ- one kil

..... .ﬂ. seven himl e : The Manifest node of the Content

..... & =i rtml Adtribute I Walle I Package containg all child elements

,,,,, W three bt |Baze and cthet sub-hanifests.

,,,,, ‘ F— (lclertifier  MAMFEST-SE4ACSED-

\ersion A reuzakle unit of instruction.

Encapsulates meta-data,

Create an Organisation

A content package consists of one or more organisations of content. By default the CP we create
has no organisations, so we have to add one.

Select the Organizations node in the manifest view and right-click.

From the context sensitive menu, click 'Add Organization’

©RELOAD 2003 page 10
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Select the new Organization and, in the attribute pane at the bottom of the workspace, enter
the value Main in the white box. This defines this organization as the default for the package.

Your workspace should resemble that shown below.

L Reload Editor L&)

File Edit Options View ‘Window Help

D@/« >4 2@ X[+ 3 B o3BT

22 Content Package - testpkg =& x|
g ‘
> i ¥ Profile: ||w|5 1.1 'I
I_:El—l testpky MANIFEST-2644C562-56BF 4-1 3C2-855F -8CCE50AC568
- supp i+l [ Metadata
""" W =ight bt El. Organizations
----- W five html [ main
""" W four bt & Resources

..... @ imscp_wipl x=sd
----- W imsmanitest xml

----- E imsmd_w1p2p2 xsd |[~=

""" s _el. sl hitzin | Organization

----- ‘ one kil

..... ‘ X Describes a particular hierarchical
seven . hitml m

..... W sl il | Walue | arganization,

..... ‘ three Hil {{Identifier QHG-C4§3EE44-4DD3-...

..... ‘ o — Structure  [hierarchical

Add Items (Content)

Finally, we can add some content to our content package. Basically, we create the structure for
our content package by adding Items to an Organisation. Adding Items to the organisation can be
carried out using menus (Edit, Add Item, or right-click, Add Item) but it is far easier to just 'drag
and drop’ content from the tree pane to the manifest pane.

Drag and Drop
Moving content around between the three panes and within panes is easy if
you use drag and drop. You can easily:
e drag and drop Files or Folders from the resources pane to become
Resources in the manifest pane
e drag and drop Files or Folders from the resources pane to become
Iltems in the manifest pane
e drag and drop Folders from the resources pane to become
Organizations in the manifest pane
e drag and drop Resources in the manifest pane to become Items in the
manifest pane
e drag and drop from the Desktop to a folder in the resources pane

NB When selecting multiple files you must hold down shift/ctrl as you drag.

Select the resource you want to add from the resources node in the manifest pane. You can start
with one.html (though you don't have to).

©ORELOAD 2003 page 11



RELOAD Editor User Manual v1.1.1

Drag the file to the Organisations node of the manifest file. A new Item appears, with the title
One. When the editor adds content to an organization it will attempt to provide a sensible name
- for instance by parsing the html to read the contents of the file’s <title> tag.

Notice that as you add content to the Organizations node, the file (and its’ dependents) are
added to the Resources node.

Continue adding content to the Organizations node. Don't worry about adding the files in order,
if you want to rearrange the order, you can always select individual Items and use the ‘Move Up’
and ‘Move Dn’ buttons to reorganise. If your content exists entirely within a folder (not the case
here) then you can drag the whole folder across to the Organisations node from the Tree Pane
and the whole adding organizations and item process is carried out automatically (you may have
to tidy up a little).

You can also delete content from the organization - select the content and click the delete
button. This won’t delete files, only the reference to them within the content package.

Once you have finished adding content, your workspace should resemble that shown below.

" Reload Editor m=x)

File Edit Options View ‘Window Help

D@« >[4 2@ X[+ % @ a3 F

22 Content Package - testpkg =18 x|
o W X B 1| profie: ms11 ~]
|__§F| testpk MARNFEST-S64 8,C562-5BF 4-13C2-5883F-3C0CE39 A C56L, -
-l =upp =
----- W eight himl
----- W five html
----- ﬂ- four ktml
----- @ imscp_wipl xsd [ Twea
----- ﬂ- irnsmanitest xml [ Three
----- E ifnsmd_w1p2p2 xsd -~ Four
----- ims_xml.x=d w1 Five
----- ﬂ- are kel ] Six
----- ﬂ- zever.hitml [ Seven
""" 'ﬂ' =i html ~[] Eight
""" W thres il Elrgl—l Resources
""" W twvo rtml =4 one html ||
R S one hitrml
------ suppdfreloadhelp .ces
------ suppdreloadeditoricon.gif

...... Supp.llﬂun38t1 JF'Q
_...Q v j

Bight | Item |
= A node that describes the shape of
.&ttributel alue | the organizstion. t can reference &

[lcertifier ITEM-8A337226-E97 .. | = I Rezource or sub-kManifest. ¥ou

IHefere___ ikt Htrnl 1 can do thiz from the drop-cown

= visible ftrue T 1§ box.
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View Content Package

Once all content has been added to the main organization, you are ready to preview the content
package in a web browser.

Click the 'Preview Content Package' icon on the main toolbar, or click the same item on the View
menu. A web browser should open on your computer.

In the browser, a two-frame page will load, the left frame will correspond to the structure of
content package you have defined, the right pane will initially be empty.

In the left pane, the top line represents the package name. Beneath the title, the first
organisation is shown, with its' title in black and the content in that organization in blue.
Clicking on any of the blue links will load the corresponding content into the main frame.

Your previewed content package should resemble that shown below.

E 1 Content Package - testpke - Microsoft Internet Explorer - [Working Offtine] Hw
i Fie Edit View Favorites Toots Help : Links F
0-O RROG PLArTE®O R-3EB-013

: Address |@ C:\Documents and Settings\colinm'Local SettingsTemprld-13658. himl M 4 Go

SEEE i

T O
-

Seven
Page Seven of the Content Package.

E] |

| % My Computer

©RELOAD 2003 page 13



RELOAD Editor User Manual v1.1.1

Tidy Content Package
The Content Package is now fully functional, but we may wish to tidy up the package before
final export. For instance, we could:
e rename the Main Organization to 'Summer Pictures’ (Select the Organization and edit the
entry in the attribute window at the bottom.)
e rearrange the content to follow a different structure - reflecting the subject of the
individual photographs. (Use ‘Move Up' and 'Move Dn' buttons to rearrange the content,
e rename the Items so that their names are more meaningful than One, Two Three etc.)

Preview Again, the Content Package previewer picks up the new name for the files.

Your previewed content package should resemble that shown below.

FEEdit‘l.n"iewFamritesTmisl'lﬂb50'@'@@@!/03‘9?@6%

Address ?} C:\Documents and SettingscolinmLocal Settings{Temp~rid-13663. himl

v

Four
Page Four of the Content Package.

If you wish, add further organizations (you can reuse the same content) and observe how the
structure of the previewed Content Package corresponds to the Organization/Item structure you
have created.
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Add Metadata

The eventual destination of a content package will probably be within a Learning Management

System (LMS) but it is also expected that the content will be placed in a repository to facilitate
re-discovery and re-use. Adding metadata to the content package will create information that

can be searched by users of the database.

The IMS Metadata specification (and the IEEE LOM, the standard influenced by IMS Metadata)
provide a starting point for adding metadata, but ultimately, guidelines for implementing
metadata at a local level are needed - to ensure that vocabularies are compatible, and that a
common core of metadata is stored for all content in your locale.

Within the UK Education community, a draft Metadata Framework (UK Learning Object Metadata
Framework: http://www.cetis.ac.uk/profiles/uklomcore/) has been produced and is in the
process of being finalised (previously referred to as the UKCMF: UK Common Metadata
Framework). It would be useful to look at the UK LOM Framework document if you wish to add
metadata to your content as it provides useful guidance.

If you recall, when we initially set up the Content Package, we decided that we should conform
to IMS Metadata v1.2.2. but we didn’t actually add any metadata. Now we can add Metadata.

Select the Metadata node in the Manifest view.
Right-click and select 'Add Metadata’ from the context-sensitive menu.

A new window appears, showing various metadata fields. There are two views, Form View and
Full View. Form View is the view we will use, it lets you add metadata into specific fields. Full
View lets you see the entire metadata record and lets you create more sophisticated metadata.

The Form View is really just a simpler representation of the full metadata record, and it is
possible to add information in the Full View which is not shown in the Form View, even though
the data is retained. For our purposes, Form View will be ideal.

From the Profile combo box, select UKCMF 1.0 - as you do so, you will see that the choice of
fields in the form changes slightly, reflecting the UK LOM Framework (UKCMF) Profile.

Using the UK LOM Framework document as a guide (available from
http://www.cetis.ac.uk/profiles/uklomcore/), go through the form adding (valid) metadata to
the form. When you have finished, click OK.

Multiple Entries

If you wish to add more than one entry for a given element (for instance if you want to refer to
content containing multiple mime types (e.g. a web page with a flash animation), you need to
use the Full View rather than the Form View.

e First change from Form to Full View in the metadata editor.

¢ Next select the appropriate element, e.g. Technical/Format, right-click and choose
Copy.

e Select the technical element and again right-click - this time choosing Paste.

e Use the scrolling list to choose a new mime-type.

If you go back to the Form View, only the first element will be shown, but the information is
stored and will be retained on save. This procedure is the same for any element which allows
multiple entries.
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Once you finish editing, your completed Metadata form (Full View) may look like the one shown
on the next page.

-~

“a Metadata - testpkg ’ ﬁ
Edit

by nl B >

Form  Full |

h Matne I “alue Attr
=/ Metadata

EID General
- Tile
----|:| Catalog Ertry
------ & Language eh
- [ Description
- [ Heryweord
- Structure
- Lite Cycle
[ Metametadata
- Contribution
-~ O Metadatascheme  UKCMF

H.H.H

b Language eh
[—:I----l_j Technical
4 Format tet
------ < Location it ffnewewe reload ac ukiextestplkg zip LRI
- Installstion remarks
- Rights
- Annotation
Ihttp:ﬁwww.relnad.au:.uk.fexnes.'tpkg.zip | Location
Attribute | Walle | A location ar & method that resolves to a
Type |LIRI location of the resource. Preferable
Location first.
Ingart ... | Export... | 0]34 Cancel |

Save Content Package

Although the content package (as held in c:\cp\testpkg\) is now complete and valid, we still
need to save it and store as a zip.

Saving the content package is simple - press the Save Icon, or select Save from the File menu.
You effectively defined the filename (package location) at the start of the session. You can view
the manifest again now: select the manifest.xml file in the Resources Pane, and click on the
view file icon in the Resource Pool toolbar. You will see the same structure that you can see in
the resources pane, along with all the metadata.

Saving the Zipped Content Package is simple too. Click the 'Zip Content package’ Icon (or select
'Zip Content Package' from the File Menu. in the dialogue that appears, type a filename
(including extension - .zip) and choose a directory - c:\cp (ie the level above the content) is
convenient.

Use Windows Explorer to navigate to the c:\cp directory. Find the file and open it with WinZip.
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4 Metadata

We have already seen some of the metadata capabilities of the RELOAD Editor in passing, but
now we shall look more closely at some of the Metadata functionality.

Creating a Standalone Metadata File

Although primarily a content package editor, the RELOAD Editor incorporates a fully fledged
metadata editor and can be used to create and view metadata files which are independent of
content.

To create a new Metadata file, Click File, New > IMS 1.2.2 Metadata File. A new blank metadata
file is created and you can choose the desired application profile by clicking on the drop-down
list.

Add Metadata as before using the form view or full view (or a combination) until all necessary
entries have been completed. Then click File, Save As ... to open the Save dialog box. Enter a
filename, and retain the .xml suffix. Save the file somewhere convenient. You can view the file
in a web browser, where you will see that it is a valid IMS Metadata v1.2.2 record.

& Mozilla Firebird u@ﬁ«

File Edit Vew Go Bookmarks Tools Help

- <lom xsi:schemalocation="http: / fwww.imsglobal.org fxsdfimsmd_v1pZ imsmd_v1pZpZ.xsd’= M
- <general>
- «titles
<langstring xml:lang="en"=Summer Pictures=< langstring>
</title>
- <catalogentry=
<catalog/ >
- =entry:>
<langstring xml:lang="en"s>
<fentry:
</catalogentry:=
<language>en</language>
- <description>
<langstring xml:lang="en">Simple exemplar content package< langstring>
</description=
- <keyword>
<langstring xml:lang="en"=Exemplar< /langstring:=
</ keyword=
- <structure:
- <50Urce:
zlangstring xml:lang="x-none">L0OMv1.0<langstring>
<fsource:
- <values
<langstring xml:lang="x-none"=Linear</langstring>
</value>
<fstructure:

<fgeneral> -
1< i | [
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5 Supporting Other Application Profiles and Vocabularies

By default, RELOAD supports the IMS Metadata v1.2.2 and Content Packaging v1.1.3
specifications (as well as SCORM v1.2). However in practise, individual organisations will subtly
adapt these specifications to meet their own requirements. For instance, when creating a
metadata record for a content package, the core IMS specification is not a great deal of use as
all the elements are optional - so a valid metadata record could consist of nothing more than an
empty metadata element tag: <metadata /> If the eventual goal of adding a metadata record is
interoperability (e.g. storage in a repository where your resource can be placed alongside other
resources and retrieved using appropriate search criteria) then some rules (common practice)
must be established governing:
e which elements of the metadata specification are mandatory
for instance it may be that you wish to ensure that every metadata record contains a
description of the technical requirements for a resource.
e avocabulary to use to describe content
for instance for the element <coverage> it may be decided to restrict responses to a list
of (United Kingdom, England, Scotland, Wales, Northern Ireland) from which anyone
preparing content to your criteria must choose.

Such rules constitute an ‘Application Profiles’ and are normally set down by a community to
ensure that resources created and used by that community (and shared, through object
repositories) are interoperable.

In RELOAD, a standard profile is loaded by default. When you create a new Content Package or

Metadata record, you can choose to load one of the supplied alternative profiles by clicking on

the menu at the top left corner of each document and choosing from the drop down list. Or you
can provide your own application profile, as described below.

Metadata Profiles

The RELOAD Editor itself doesn't know anything about individual application profiles and
vocabularies, but will tailor the metadata form it displays based on any profile that it is supplied
with. When you create a metadata file, a drop down box appears at the top left of the metadata
form which allows you to specify a specific application profile. At present (v.1.1.1) three
application profiles are included: IMS-LRM (the basic IMS Learning Resource Metadata profile),
UKCMF v1.0 (UK Learning Object Metadata Common Framework) and LTSN v1.0, prepared by the
Learning and Teaching Support Network - see the box below). The drop down list is populated
automatically by the RELOAD editor which reads the contents of a folder of helper files situated
at: [RELOAD INSTALL]/helpers/md/profile/ . You can add your own application profile here.

. . = 1 helpers
The metadata helper directory structure is as follows (and the content 2 o
packaging and scorm helper directory structures are the same): There =2 md
are three directories, profile, schemahelper and vocab. The profile 2 profie
directory holds the profiles themselves, and these refer to a &2 schemahelper
schemahelper file (which provides help text etc.) and a vocabulary file 2 vocab
(which provides the correct vocabulary for a given profile). &3 scorm

To add a new profile, you need to provide three XML files, the profile itself, a schemahelper,
and (optionally - you could use an existing one) a vocabulary. You would normally base your
profile on an existing profile - so the easiest way to create a new profile is copy the relevant
files, rename them and edit them. The text snippet below shows the first few lines of the IMS-
LRM profile XML file and shows how it refers to the schemahelper and vocab files.

<?xml version="1.0" encoding="UTF-8"?>

<!-- RELOAD Metadata Profile -->

<profile name="IMS-LRM" vocabfile="ims-1lrm en vocab.xml"
schemahelperfile="imsmd en helper.xml">
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Editing is a relatively straightforward process of going through the elements and sub-elements
until you find the ones that are of relevance to you, then making the necessary change. The
order in which elements appear can also be changed as the order of elements in the profile XML
file defines the order on the metadata form: normally General, Lifecycle, Metametadata etc.

In the example below, a fourth profile ‘Customised-LRM' has been included.

"% Reload Editor
File Edit Options Miew Window Help

D> B« ~ |4 @ X[+ ¥

ElMetadata - C:\tmp\ipplication Profile.xml
Form | Fun |

Profile: MS-LRM |
Customized-LEM
IMS-LRM
SLTSM version 1.0
LIKCMF wersion 1.0
Title

[Pt

Once you have created a customised profile, you can set it to be the default profile by choosing
View, Preferences ... and choosing the Metadata Preferences tab.

For the UK education community, an emerging application profile is
being prepared under the auspices of CETIS and is entitled the UK
Learning Object Metadata Framework (previously referred to as the
UK Common Metadata Framework) For more information, see:
http://www.cetis.ac.uk/profiles/uklomcore and in particular the
document entitled: uklomcorevOp1.doc which effectively goes
through the whole Learning Object Metadata specification and
explains how the UK community interprets the various fields.

Content Packaging Profiles
Profiling for IMS and SCORM Content Packages is achieved by editing the corresponding files in
the cp and scorm directories under the helper tree.
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6 SCORM Elements

A new feature in v1.1 of the RELOAD Editor is support for editing SCORM 1.2 packages. SCORM
(the Shareable Content Object Reference Model) builds heavily on the IMS Content Packaging
specification and so IMS CP and SCORM v1.2 packages are very similar, but there a few important
differences:
e SCORM packages can be of two types - a resource package and a content aggregation
package.
e Metadata can be kept in an external file and referenced, rather than being kept within
the content package as part of the main manifest.
e SCORM packages utilise 5 extra elements which provide information on how the package
behaves. These five elements are:
o Prerequisites
o Max time allowed
o Time Limit Action
o Data from LMS
o Mastery Score

This section will describe the SCORM v1.2 specific features.

Types of SCORM Package

SCORM Packages can be used for two purposes - either to store and transport content as ‘assets’
for future use, or as organisations of content for delivery via a Learner Management System LMS.

SCORM Resource Packages are the simpler of the two package types - the manifest provides
content metadata and describes the files which make up the resource, but the organization
element is empty and no information about how the content is structured is kept as can be seen
in the following screenshot of a valid SCORM resource package.

'+ Reload Editor =] <

File Edit ©Options Wiew ‘Window Help

DBl | i 2@ X|+ % |8 | 3B @
2:SCORM Package - Solar Movice =10f x|
S 4
W i X ) Profile: [scoRM 1.2 ¥ |
I_% Salar Movice SolarGeom -~
- images (=] Metadsta
----- adlep_rootvip2 xad . Organizations
----- imscp_rootyl gl p2.ssd =B Resources
""" W irmsmarifest ol B4 solarnovice hienl
----- B irmsmd_rootv! p2pt xsd - [F] imagesispovwered gif
""" &) ims _xmil s - imagesiSolarGenmivesthase oif
""" &) jscore jar - [B imagesiSolarGeomiseascape base? gif
""" progress jar --[F) imagesiSokarGeaticioudyday gif
""" & SolarGeom jar - [B imagesiSolarGeom/starrynighteast2 ot i
""" solarhovice bl - imagesiSolarGenmiciearsky oif
""" solarnovice jsn -2 imagesiSolarGeomsun.gif
------ imagessZolarGeomiday .oif
------ image=rSolarGeomhight oif
------ imagessZolarGeomidaven2 oif
------ imagesfSolarGeomidavens. gif LI
|Manifes‘t |
e The Manifest node of the
Attribute RS | Content Package containg all

child eletnents and other

Base zub-Manifests,

Iddertifier  |[SolarGeom
wersion |11

A reuzable unit of instruction.
Encapzulates meta-data,
organizations, ahd resource
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SCORM Content Aggregation Packages are more complex, and in this case at least one
organization must be available to describe how the content is structured. SCORM Content
Aggregation Packages are similar to IMS Content Packages, but can make use of the extra
elements defined by the SCORM v1.2 specification (and see below).

SCORM Metadata

SCORM Metadata is based extensively on the IMS LRM specification, and ADL (Advanced
Distributed Learning, who manage the SCORM initiative) do not impose a specific application
profile. The difference between SCORM Metadata and IMS Metadata is that SCORM Metadata can
be kept in a file external to the content package.

If you are creating a SCORM v1.2 package and wish to make use of externally held metadata,
then you must use the ADL:Location element.
e Right click the Manifest as below and click Add Metadata
e Right click the Metadata element and click Add Schema - the node will appear pre-filled
with ADL SCORM
e Right click the Metadata element and click Add Schema Version - the node will appear
pre-filled with 1.2
e Right click the Metadata element and click Add Location - You can then type a URI for
the metadata file in the box provided. You should of course make sure that the metadata
file is valid XML.

SCORM Specific Elements

The main area where SCORM v1.2 differs from IMS CP v1.1.3 is in the support it provides for
interaction with Learner Management Systems (LMSs). An extra five elements are defined which
describe these interactions, and the LMS can use these elements to define a set of rules which
control a learners progression through content to be defined. Each of these elements is optional.

prerequisites

This element defines any other Item which the learner must have completed satisfactorily
before they are allowed to access the current Item. This can be used to define multiple routes
through learning materials.

maxtimeallowed

This is the time (in seconds) that a LMS would permit access to the item for. For instance you
may wish to restrict access to a simple assessment, forcing all learners to complete within 15
minutes.

timelimitaction
This is the action specified if the ‘max time allowed’ is exceeded. The user is provided with a
choice of four built in actions:

e Exit, no message,

e Exit, message,

e Continue, no message,

¢ Continue, message.

datafromlms
This element allows initialisation data to be sent from the LMS to the Item on launch.

masteryscore
This is a normalised score (between 0 and 100) which must be achieved to indicate satisfactory
completion of an item.
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. aoL| | .
These elements are accessed by clicking the icon on the toolbar. The editor pane for these
elements is shown below
SCORM Properties
Prerequisites '
ITEM-DD3345F3-DEDS-A101 -1 879-421 CCB03762C Five (ITEM-985C27C-7274-B925-FC4D- [
Four (ITEM-35BDDTO3-CFI7-A102-AFFE '
One  (ITEM-DD3IZ4SFS-DED3-4101-1879
Seven (ITEM-EEOCS496-8005-6C59-7ES ,
& I Six (ITEM-25A0024E-0CCC-FE50-551 2-7 |
Three (ITEM-43DEOE4 L -323E-5535-8E3,
Twwa (ITEM-DCCT060-0CE4-417A-ATOF '
Alirikute Vakie 1 Sundial interface (ITEM-9DAZCES2-CFEB! .
Type lalce_script | [
< | B
Max time allowed Data from LMS
el |
Tirme limit action Masterny score '
|ex|,message |Eﬂ
exit,no message :
Cantinle no message |
cantinue massags |

Once an Item carries SCORM information, its Icon changes from a simple rectangle to one
containing a central spot. In addition a plus sign appears to the left side of the Item and when
expanded, a list of the SCORM elements utilised appears. An expanded Item node is shown
below:

r"'i Reload Editor g@1

File Edit Options Wiew wWindow Help

D v | % @ X|+ % B o I B &

23 SCORM Package - test-folder =121
o S 4

I | Profile: ISCOHM1.2 -]

% test-folder MANFEST-SEADCDT -61F A-07 44-C404-D40ECESET 244, -]
- cortent .. =] metadsta

o {&] imsep_vipt xad EI- Organizations

fro ﬁ irmsmanifest xml E||D contert

fro E irstmd_wlp2p2 xsd =[] Eight

e ims_xml.xsd 0L Prerequisites

----- A0L Max time allovwed
----- ADL Time lirnit action
=-A0L Mastery score

------ O Five
------ O Four j
lEigHt item |
Attributel Vsl I A node that describes the shape of
the organization. | can reference a

lickertifier |ITEM-947BO0FAE-F41 . 2
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7 Further Actions

References and Dependency

The RELOAD Editor is essentially a tool for organising and reorganising content and the tools
possess many simple features which assist the user in their task.

Finding References ¥
In complex content packages, it can often be hard to match up Items and By
the resources they reflect. By selecting a given item and right-clicking, a =1
context sensitive menu appears with the option Find Reference at the
bottom (see screenshot). Clicking this option will move focus to the ¥ Delete
relevant resource in the resources tree. When an Item is selected the name 4+ Move Up
of the associated resource also appears in the Attribute Pane. If you wish to & Move Down
reassign a resource to the item, simply click on the Referenced Element
. . . [] add Item
attribute and select a new resource from the drop down box which lists all
current resources. Add Metadats
% Find reference

Adding Files and Dependencies

Although the RELOAD Editor parses HTML files when adding them to the resources tree, it cannot
exhaustively add all dependencies for all resource types. This is especially the case for pages
which reference flash movies and java applets where the movie or applet may itself refer to
content within compiled code.

In such cases, additional files can be added manually. By selecting a given

resource and right-clicking, a context sensitive menu appears with the dh

option Add File towards the bottom (see screenshot). Once selected, a By

new file icon appears at the appropriate point in the resources tree and R

the relevant value (a path and filename) can be added in the Attribute % Delete

Pane below. In addition to single files, a given resource may well depend i

upon another resource. By selecting a given resource and right-clicking, a +

context sensitive menu appears with the option Add Dependency at the & Move Down
bottom (see screenshot). Once selected, a new dependency icon appears 2dd Metadata
in the resources tree and the relevant resource can be selected from the _ _

drop down list in the Attribute Pane. The Find Reference option can be Add File
used to re-find the relevant resource for a given dependency as above. <7 Add Dependency

Manifests and Sub-Manifests

The core element of a content package is the manifest, this is the organisational level which
includes metadata and all the content within a given content package. As well as the Metadata,
Organizations and Resources structure which we have already come across, a manifest can also
include sub-manifests - effectively whole content packages, stored within itself. Sub-manifests
can contain their own metadata and will of course contain organization(s) and resources. They
can also contain further sub-manifests, allowing very complex file structures to be created. We
use the terms aggregation and disaggregation to cover the processes of adding and removing
sub-manifests from a content package.

Aggregation

Aggregation is the process of combining more than one content package manifest into a single
Content Package. Right clicking on any manifest will display a content sensitive menu with
Aggregate ... as the final menu item. Choosing this option will launch a dialogue box which will
ask you to choose the manifest (or zipped Content Package) to aggregate.
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There are two main ways to aggregate content: either as a sub-manifest inside a standard
content package

o =
'+ Reload Editor -J0Ed
File Edit Options Wiew Window Help
D B« > | BR X| |+ % |8 o | 1
2 Content Package - test-agg? =13 =]

e 4
W . X B Profie: fms11 <]
Iél test-agol MAMIFE=T-9E450DEBD-CDE5-25A 3-BAEG-G5ABCODDEEEZ
i submarn . Creanizations
i Submanifest1 -@ HESDU[’CES
| imsop_vipt xsd | 5@ MANFEST-BS7470E4-C1EA-BECO-CCCF-082A8TEARFS
W imsmanitest xml - & metadsta
- E itmamed_v1 p2p2 xs . Organizations
B ims_xml.xsd % Fe=ources
|Manifest
. The Manifest node of the Contert
.ﬂ.ﬁributel Yalue I Package containzg all child elemerts
|Eiaze and ather sub-Manifests.
lidertifier  [MANIFEST-SE48DEE0-C... . G
: reusable unit of instruction.
ﬂ Iﬂ E‘v’ersu:un i g k]
s — — —

or as two sub-manifests side by side within an otherwise empty Content Package.

& Reload Editor

(=] %]

File Edit Options Wiew wWindow Help

DE @ - > R X+ ¢ |8 ol
2 Content Package - test-agg
- i X B 1| Profie: ms11 =]

|_§| test-agy

i‘ submanifest
i‘ submanifest2
----- @ imscp_vw1pl xsd

MARFEST-B3971 2D6-E7ED-1EDS-4D5C-F1FA4300C 455
----- . Croanizations

----- rél Resources
EI---@ MARIFEST-4562051 8-DEFT-237E-AEEE-3F1 3004357 35

-l imsmaritest xml - B Metadata
----- E imamo_v1p2p2 xsd . Crganizations
B itris el = #-E] Resources

EI@ MANIFEST-CCEDSZ2DE-8502-FBCT-510C-DCAEESEAF SCA,
- Metadta
. Organizations
-] Resources

.

.

Atribute | Value [ manifest
|Baze -

The Manifest node of the Content
ll ILI ilder‘ltifier MAMFEST-B297120... | = Package containz all child eletmernt s

Although both these options are equally valid it is probably better practice (if more work) to
aggregate the two sub-manifests side by side. Aggregating content packages can be a very
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complex business and there is always a risk of files in individual sub-manifests having the same
name (one overwrites the other) or non-unique identifiers (if you let Reload assign your unique
identifiers it will always make sure they are unique). Ultimately however, the structure should
be determined by the learning material.

Of course working with sub-manifests is more complex than working with simple content
packages and many Managed Learning Environments and Repositories which are not yet fully IMS
CP compliant will have problems with aggregated content. So Beware.

Disaggregation

Of course anything which has been aggregated can also be disaggregated. Right-clicking on any
sub-manifest will display a content sensitive menu and the last option in the menu will be
Disaggregate ... Clicking Disaggregate ... will launch a dialog box which will ask you to choose
which directory to save the disaggregated content to. Once chosen, all the relevant files are
copied across, including the manifest file. Within Reload, you can then Open this new Content
Package as usual.
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